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Version 8.5 Update Supplement 

Installing the New Version of Pulsonix 

It is recommended that you back-up all libraries, designs, technology files, profile files and report 
files before installing the latest version. Other than for any technical reason, this is good working 
practice, although you should already have a backup of this data! 

To install Pulsonix, insert the CD or double-click on the download executable and wait for a short 
time. The Autorun facility will start the installation procedure. Follow the on-screen commands from 
the install wizard. You can install Pulsonix 8.5 on top of your existing installation or alongside if you 
prefer; however, you do not need to uninstall the old version first. 

Licensing 

Version 8.5 requires a new license. If you are using a version of Pulsonix earlier than Version 8.x, 
you will require a new license, this would have been supplied to you under the terms of your 
maintenance contract. 

For existing users upgrading from a previous version, it is recommended that you save the new 
license and overwrite the existing one. When requested during installation, simply click the No 
Change In Licensing check box on the licensing page of the installation wizard. The License 
Manager can be used to add new licenses and make changes to network licensing after the 
installation has been completed. Existing users will be supplied with the new license if they have a 
valid maintenance contract. 

Windows XP Support 

Microsoft ended mainstream support for Windows XP in April 2009. In recognition of the widespread 
use of Windows XP in some regions, Pulsonix has continued to be supported on Windows XP. 

In line with our Support Policy, and bearing in mind that Windows 8 has now been available for more 
than two years, this will be the last major release of Pulsonix to be supported on Windows XP. More 
information on support for different versions of Windows can be found on the Support section of our 
web site under O/S Life Cycles. 
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Features Changed or Added in V8.0 

In the following feature descriptions, you will find some features documented that were included in a 
late release of 8.0. They have been documented here to highlight them for you. 

Import Ariadne (Advanced Import Option) 
On the Import Ariadne dialog, there is a new check box for adding net classes to each net that were 
not originally assigned to a net class in the Ariadne PCB design. 

 

Output LPKF 
On the LPKF Setup dialog there is a new option Separate Plots For All Slots. Slots are non-round 
holes and can be plotted in two different ways (routed using a NC Drill Excellon-type output or 
punched). 

Check the Separate Plots For All Slots to plot plated and unplated slots on their own separate layers 
within the output file. Leave the box unchecked to include plated slots with the plated drill holes, and 
to include unplated slots with the unplated drill holes. 
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New in Version 8.5 

Panel Editor 

Overview 
Pulsonix 8.5 introduces the Panel Editor. This is used post-PCB design editing and enables you to 
collect PCB designs into a single ‘panel’ and position them ready for plotting. There are tools within 
this option to create the manufacturing plots in Gerber, Excellon and PDF etc. format using the CAM 
Plot dialog. 

When creating Panels, it is strongly advised that you work with your manufacturer to get the best out 
of Pulsonix and so you also fully understand their own capabilities and working tolerances. 

 

Panel Layer Visibility 

When viewing designs in the Panel Editor, it should be noted that the electrical layers of a panel 
design are not fully drawn with every detail; instead the board is represented by an infill colour. 
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What can you do with the Panel Editor? 

You can import a single PCB design or multiple PCB designs, then create arrays (called Panelise). 
You cannot import Gerber files, this editor is used to add Pulsonix PCB designs only. You can add 
the same PCB design to create multiple copies in an array or you can add multiple different PCB 
designs to get the most out of your panel. For example, you can add a circular board and then an ‘L’ 
shaped board to fit around it. 

Once the boards are positioned, shapes can be added for documentation purposes. There are also new 
shape items for creating tab-routs and V-Score profiling for physically removing the finished PCB 
from the panel. 

Other documentation items can also be added, these might be Bitmaps, drill tables or user reports. A 
reminder when using Bitmaps; they cannot be plotted to Gerber because of pixel resolution 
limitations. Free pads and Doc Symbols can be added, these might be used for fiducial markers or 
panel mounting holes. Doc Symbols might also be used for adding test coupons as well. Text can be 
added to a panel for documentation purposes, this might be straight text or barcode style text to create 
a Barcode. 

Construction Lines can be added to a panel to ‘guide’ various items when creating it. 

Import options allow Gerber and DXF files to be imported to aid construction of milling paths and 
tab breakouts. 

Additional colour items are available in the Colour dialog under the Others tab. These are specific to 
the Panel editor for new panel items. 

Before plotting using the CAM Plots dialog, the panel can be checked using the panel DRC dialog. 
This has new checks specific to panels and panel functionality. 

Creating a New Panel 
There a two methods for creating a new Panel Design: 

• Using the Panel Wizard from the New Wizard option (File menu, New, Wizards) 

• Using the New Panel Design option from (File menu, New, Designs) 

Both methods are described below. 

Creating a New Panel using the Panel Wizard 
From the File menu, New option, Wizards tab, you can create a new panel using the Panel Design 
Wizard. 

 
The Panel Wizard guides you through adding Technology, the PCB Design, panel details, such as 
Size and its Layout. A preview window displays your choices as you make them. 
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Note: If you don’t select a Technology file as this stage, a Technology will be created using the PCB 
Design on the following tab. 

From the PCB Design page, choose the design to be used. You can leave this blank if you wish and 
interactively add the PCB design or designs at a later stage. This dialog also allows you to match 
mismatched technologies. 

 
The Panel Size dialog enables you to choose the size required. Either type the size or use pre-defined 
panel sizes from the drop down list available. You can also choose to use an existing panel from a 
previous design. 
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The Panel Layout page enables you to choose panel parameters, such as the border distance, the 
number of PCB designs on the panel to create the array and the distance between the designs 
themselves. 

 
The Finish page enables you to create a new panel and start editing it or save it as a panel design and 
then edit it. 
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The Panel Editor 

Creating a new Panel Design 

From the File menu, select the New option and Designs. Select Panel Design. 

 
Select the Technology file and/or Profile file you wish to use. Once OK is pressed the Panel Editor 
will open, from there you can add design items to it. 

Adding a Panel Outline to the Panel 

The first operation should be the addition of the actual panel outline. Use the Insert Panel Outline 
option from the Insert menu. You may choose a square or rectangle shape and it will always be a 
closed style. This outline appears on all layers in the design. When adding, use the standard 
interactive options to create and adjust the size and position (Type Coordinate and Type Offset etc.). 

When zoomed in sufficiently, you will see small directional arrows on the outline, these indicate the 
routing direction. 

If you decide you’d like to change the style of this Panel Outline to another shape style, right click 
and choose Change Shape Type from the context menu. Conversely, you can also add any style of 
shape to the panel design and convert it to a Panel Outline shape. 

Adding PCB Designs to a Panel 

Once the Panel Outline has been added, you can use the Insert PCB Design option to add Pulsonix 
PCB designs to it and map its non-electrical layers. 
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Each PCB instance added must have a unique name, enter the required name in the Instance Name 
box. These names are only used to uniquely identify each PCB instance in the panel.  

Use the Browse button to choose the PCB design to place in the panel. Its file path and description 
will be placed in the dialog information boxes.  

There are two ways of locating the PCB design file in the future when the panel design needs to 
access its data, for example when generating plots. The first way is to use its absolute file location. 
The second way is to access it in the same folder as the panel design, or in a folder below the panel 
design. Do this by checking the Relative Path From Panel Folder box. This is useful when saving 
the panel design with the PCB design, because if they are both then moved to a different folder the 
panel will still be able to find the design.  

The number of physical layers in the PCB design, and the layer span structure must match the Panel 
Design. If they do not you will get an error message and not be able to add the PCB design. If the 
physical layers do match you will be given the choice of mapping the names of the non-electrical 
layers in the PCB design to the layer names in the panel technology data. If you do not map the names 
yourself, only the non-electrical layers with names that exactly match will be used when creating 
plots.  

To map a layer name, select the PCB layer you want to map in the Unmapped Layers column, then 
select the panel layer you want to map to in the Panel Layers column and press the "<<" button. If 
the sides are the same the layer name should move columns. To remove a layer name mapping select 
it in the Mapped Layers column and press the ">>" button. It will move to the Unmapped Layers 
column. Any non-electrical layers left in the Unmapped Layers column will not be used for this 
PCB design when creating plots from the panel.  

Press Add to add a single instance of the PCB design, or press Add Multiple to enter the Add 
Multiple Panel PCB Items dialog to add an array of PCB designs. You will now be able to position 
the PCB instance within the panel.  
 
If you attempt to add a PCB Design instance that has mismatched layer items, you are presented with 
an error message dialog: 
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You will not be able to add the PCB design to the panel and must correct the layer within that design 
first. 

Editing the PCB Instance 

Once added to the panel design the individual PCB instances can be moved, rotated and aligned. By 
default, the origin of the PCB design is the bottom left corner of the board extents, but you can define 
a PCB Panel Origin in the PCB design using Place PCB Panel Origin from the context menu. The 
advantage of using a panel origin is when the PCB design is updated in the panel it will stay at the 
same place even if its board extents has changed.  

Use Properties on selected PCB design instances to change the PCB Design file they refer to or to 
change the layer mapping. 

Adding Multiple Designs or Rearranging Multiple Designs 

If you wish to add multiple arrays of the same design, you should either start the panel with the Panel 
Wizard or add a PCB Design Instance, then use Replicate (if only one design has been added) or 
Rearrange Multiple Items if multiple designs have been added. 

One the designs(s) have been added and positioned, further detail can be added. See further down this 
section under Adding More Detail to the Panel to see what can be added. 

PCB Panel Origins 

In a PCB design, with nothing selected the context menu contains a new option Place PCB Panel 
Origin. Use this to place an origin in the PCB design that will be used when adding the PCB to a 
panel design. If it does not exist the lower-left of the board outline bounding box will be used. 

This origin has its own colour in the Colours dialog, Others page. 

 

Exporting and Plotting Panels 

As well as using the standard CAM Plot dialog to export panels in Gerber, Excellon, PDF etc. format, 
you can also extract Reports, create custom reports from the Report Maker option, export to ODB++, 
generate LPKF ‘plot’s and export to DXF. 
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When using the CAM Plot Wizard to create a new plot or edit an existing one, there is a small 
exception to the standard dialog with the addition on the Output page. If Panel is selected from the 
drop down list as the Process: you can choose to output specific outputs based on what is required to 
manufacture the final panel. 

 

Importing to the Panel Editor 

Using the Import Design Data option from the File menu, you can import Gerber and DXF files to 
facilitate the panel creation. Gerber or DXF files may be used for previously created tab paths. DXF 
files may be used as an alternative to Bitmap for logos (DXF can be plotted to Gerber). 

Import DXF – Within this dialog you can specify that DXF layer shapes are imported as one of the 
special panel shapes (Outline, Tab-Rout or V-Score). Any Tab-Rout shape is acceptable, but only a 
single panel outline, and only horizontal/vertical single line V-Scores will be created. 
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Import Gerber – In the dialog there are new check boxes to choose to read shapes as one of the 
special panel shapes. Any Tab-Rout shape is acceptable but only a single panel outline, and only 
horizontal/vertical single line V-Scores will be created. 

 

Panel Colours 

New colour options have been added to the Colours dialog on the Others dialog. 
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Using DRC in the Panel Editor 

The Design Rules Check dialog has been modified for specific Panel features. 

 

Adding More Detail to the Panel 
Additional new features have been added to Pulsonix for use when in the Panel Editor. These are used 
for specific functions and processes, it is important to choose the correct shape type to match the 
output you require. 

• Panel Outline – similar to a board outline but this is a special design item to define the 
overall panel size. This has been described previously above. 

• Panel Tab-Rout – once the panel has been manufactured, the boards must be removed 
from the panel. To do this, the board can either be milled out using an NC Drill machine 
where the board outline is milled between breakout tabs, or it can be ‘snapped’ out using 
cut lines created via the V-Score outline. 

• V-Score Line – this is a straight line added to the panel to indicate a ‘score’ line for a 
scoring machine. Once the panel has been scored, it is physically snapped or broken out of 
the panel. 

• Breakout tabs – when a solid Panel Tab Rout has been defined, you can ‘cut’ it into 
smaller lines to show the routing path for the milling machine. The small portions of the 
path that remain in-place to hold the board in the panel after routing are called ‘tabs’. 

• Change Shape Direction – this is available on the context menu for all panel special 
shapes. 

Tab-Rout 

The Insert Panel Tab-Rout mode allows you to add the tab-rout shape using one of five shape styles 
provided: Rectangle, Circle, Triangle, Polygon and Line. Panel tab-routs are created using an unfilled 
shape which is either closed (non-intersecting and ending at the start point) or an open polyline. These 
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shapes can be edited after being added to move, add and remove corners, and can have breakout tabs 
removed from them using the Create Breakout Tabs option. 

From the Insert menu, select the Insert Panel Tab-Rout > shapes option. 

If you decide you’d like to change the style of this Tab-Rout to another shape style, right click and 
choose Change Shape Type from the context menu. 

Tab-Routs can also be created by selecting a PCB Instance in a panel design and using the Create 
Tab-Rout Around PCB from the context menu to create a tab-rout around the edge of the selected 
PCB board outline. The shape will be created so that the inside edge touches the centre line through 
the board outline, which represents the outside edge of the PCB. 

 
Once added to your panel, this design item type can be output using the CAM Plot dialog and 
selecting its type from the list when Panel is selected as the Process. 

V-score Line 

Panel V-Score lines are created using a single orthogonal line. These lines can be edited after being 
added to move, rotate, lengthen and shorten them. They cannot be changed from being a single line 
parallel to the x-axis or y-axis. 

From the Insert menu, select the Insert Panel V-score Line option. This design can only be inserted 
as line items. 

V-Score lines can also be created by selecting an orthogonal board outline in a PCB Instance within a 
panel design and using the Create V-Score Along PCB Edge from the context menu to create a line 
along the selected PCB board segment. 

 
If you decide you’d like to change the style of this V-Score Line to another shape style, right click 
and choose Change Shape Type from the context menu. 
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Once added to your panel, this design item type can be output using the CAM Plot dialog and 
selecting its type from the list when Panel is selected as the Process. 

Create Breakout Tabs 

The Create Breakout Tabs function allows sections of a panel Tab-Rout to be removed between 
two cut lines to create a breakout. Select the Create Breakout Tabs option from the Edit menu. You 
will notice the cursor change to the "scissors" cursor. 

You can right click and from the context menu, select Define Rout Breakout Tab to define the 
breakout tab parameters: 

 
The current tab width is shown on the status bar at the bottom of the screen. To change it, right click 
the mouse to use the Define Rout Breakout Tab option from the context menu. Type in the required 
tab width using the current design units. 

When using this dialog, the initial default parameters are taken from the Setup menu and Design 
Settings option. For details about the parameters, see the Panel Defaults section below. 

Remove Breakout Tabs 

There is also a Remove Breakout Tabs option on the Edit menu to selectively remove tabs that have 
been added to the panel. 
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Panel Defaults 
The Design Settings option on the Setup menu now contains three new Panel defaults: 

• Panel Outline 

• Panel Tab-Route 

• Panel V-Score Line 

 
Line Style - choose the line style from the drop down list. This will be used to define the Tab-Rout 
path in the Panel. Select a line style that has the correct width for the milling tool to be used to cut 
around the PCB boards in the panel.  

Breakout Tab 

This section defines the parameters to be used when Create Breakout Tab is used to create breaks in 
tab-routs. The PCB board is assumed to be on the left side of each tab-rout segment (looking along 
the segment in the direction of the arrows drawn on it). 

Tab Width - this defines the width of the break in the tab-rout. It is the gap required between the 
edges of the ends of the tab-rout segments.  
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The example below shows the Tab Width distance for a straight line breakout tab.  

 
The next example shows how the Tab Width distance is defined when an angle is applied to the tab.  

 
Angle Tab Ends Into Board - Some manufacturers prefer the tab-routs to turn slightly into the board 
where a breakout tab is required to ensure that the tab breaks inside the board. Check this box if you 
require angled tab-rout ends. The values define the Angle and the Length as follows: 

 
Note: If for some reason you wish the tab to be directed 'outside' of the board outline, use an angle 
greater than 180 degrees. 

Drill Holes In Tab 

Drill holes can be added in the breakout tab to aid breaking the PCB boards out. Choose one of the 
three options.  

No Drill Holes - Select this if you wish to create a plain breakout tab without any drilled holes.  

Single Centred Drill Hole - Select this if you wish to add a single drilled hole to the centre of the tab.  

  
The Pad Style is selected from the drop down list and is taken from the Technology file Pad Styles. 
Ideally, you should define a style that is “drill only” with no 'pad' land.  
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Multiple Drill Holes (Mouse Bite) - Select this if you wish to add multiple drill holes (commonly 
called mouse bites, rat bites or perforation) to your breakout tab. These "nibble" into the board and 
ensure that the snap line is within the board when broken out from the panel. 

 
The Pad Style is selected from the drop down list and is taken from the Technology file Pad Styles. 
Ideally, you should define a style that is a drill only with no 'pad' land. 

Holes Count - use this to define how many holes will be drilled between the breakout tab. The holes 
will be positioned in the centre of the tab. 

Hole to Hole Gap defines the distance between the drill holes with the spacing taken from the edge 
of the one drill hole to the edge of the next. Use a combination of hole count, size of drill and hole to 
hole spacing to ensure the mouse bites span the tab.  

Hole Offset is the amount that the drill holes are 'indented' into the board. This value is taken from 
the inside edge of the tab-rout to the centre of the drill hole. Use this to further ensure the break line in 
the tab is inside the board. Care should be taken to not move the holes too far into the board where 
they may clash with items on the PCB.  

Note: If you wish the holes to be drilled 'outside' the board outline, use a negative offset value. 
Normally, the number will be positive.  

Special Cases 

When the tab has an end angle, the Hole Offset is now taken from the centre of the drill used for the 
tab. This is shown in the following example. 
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Report Maker in Panels 
As well as being able to include Report Maker files in the Panel itself as a User Report, the ability 
to create specific Panel reports has been added. The new Panel check box enables reports to be run 
from a panel design. 

 
If you have a report such as a pick and place placement list that can be run from a PCB design, the 
new top-level command below will enable this to still be run in a Panel Design: 

Include PCB Instance Contents 
The Report Maker can now accept the following commands:  

List of PCB Instances 
Position / Rotation etc. 
PCB Instance Name 
PCB Design Name 
PCB Design Path 

List of Panel Shapes 
Type 
Length 
List of Segments 
List of Cutouts 

Panel Checks in Layer Class dialog 

There are two new check boxes in the Layer Class dialog to support Panels: 

 
Use these check boxes to include items that appear on layers that use this Layer Class in DRC 
checks performed using the Panel Items In Design check. 
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The two Panels check boxes allow Check Items Outside Board to be flagged during checking and 
the ability to Draw Shapes in Panel Designs when they appear on a Layer that uses this Layer Class. 
It means shapes can appear in the design but will not be used if the design is used within a Panel. 

Rearrange Multiple Items Changes 

The Rearrange Multiple Items option now let’s you rearrange Pads with different styles and 
Components with different symbols. This is particularly useful when rearranging pads with different 
styles in the Footprint Editor or Components in a design such as a selection of resistors and capacitors 
which you may wish to line up in arrays. 

Set Symbol Origin At Centre Of Pads 

A new option available from the context menu when editing Symbols or Footprints. Set Symbol 
Origin At Centre Of Pads sets the symbol origin at the centre of the box which includes all positions 
of all the selected pads and mounting holes. If nothing is selected, it will use all pads and mounting 
holes. This option is available as a command to be assigned to a shortcut key. 

   
Symbol as initially 
created with Pin 1 as the 
Symbol Origin 

 All pins are selected (or nothing 
selected), then right click to  
reveal context menu option. 
Select Set Symbol Origin At 
Centre Of Pads option 

 Symbol Origin has now 
been moved to the centre 
of the pads 

New Enhanced Graphics Mode 

A new option (enabled by default with an 8.5 installation) is available to use Enhanced Graphics in 
Pulsonix. This new mode can be toggled on and off from within the Options dialog and Display. 

 
You may find that you need update your graphics driver in order to fully utilise this feature. 
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Display Page Numbers in Design Browser 

When using the Design Browser, there is a new option on the context menu to Show Page Numbers 
next to the page name. When selected, this will put the page number in square brackets after the page 
name, as shown in the example below [1], [2] and [3]. 

 

Shortcut Keys availalble on Dockable Bar options 

Shortcut key commands are available for a selection of dockable bar options to provide fast access 
during use: 

 Find Bar: 
  Select All Find Items 
  Select Visible Find Items 
  Refresh Find Bar 
 Layers Bar: 
  All Layers On 
  All Layers Off 
  This Side On 
  This Side Off 
 Both Errors Bars:  
  Find Error 
  Delete Error 
  Lock/Unlock Error 
  Toggle Sort Order 
 Component Bin: 
  Delete From Bin 

Add Part To Design From Lib Manager 

When using the Library Manager on its Parts page, if you have a current PCB or Schematic design 
open, with a single part name selected from the Contents: list, you can interactively add the Part to 
the design. You can also add a number of copies of the selected Part to the designs’ component bin.  

Use the Add To Design button to insert the Component to the design or add to the Component Bin 
with this option selected. 
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When selecting the Add To Comp Bin check box, the Add button changes to Add To Design Comp 
Bin. 

Drag & Drop To Library Manager 

For some file formats, Pulsonix now supports the ability to drag and drop the file onto the Library 
Manager to create whatever library information it detects in the file. This could be any combination of 
SCM Symbols, PCB Footprints and Parts. The methodology extends to native Pulsonix binary design 
as well (.scm and .pcb). Dropping these files onto the Library Manager will open the import manager 
dialog. 

On drop, the following dialog is displayed: 

 
This dialog asks you to confirm the Technology files that will be used during import. Select the 
required Technology and press OK. 
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You are presented with the Save Items dialog: 

 
The import dialog will read the contents of the file and determine their type, they will be displayed in 
the appropriate library list. The import files are capable of containing multiple items as well as 
individual items. 

For each library, either choose the library to import into, or choose [New Library] from the drop 
down list. When you press OK, the Save As dialog will be displayed into which you can type the new 
library filename.  

 
Once OK is pressed, a confirmation dialog is displayed. Your new library items are now ready to be 
used. 

 

Support for Additional External Libraries 

Through its new PLX Native ASCII Format files, Pulsonix can now support additional external 
libraries available from PCB Libraries (www.pcblibraries.com), Accelerated Designs using their Ultra 
Librarian product and SnapEDA. Each vendor provides different and unique capabilities of library 
production in ready-to-use libraries. 

Each library supplier will now write .plx format which can be read into the Pulsonix Library 
Manager using the new drag & drop functionality described above. 

For more information, please contact your local Pulsonix sales office who will be able to help and 
advise you further. 

www.pcblibraries.com
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Suppress Properties on Double-Click action 

New Options | Interaction option Suppress Properties on Double Click. If selected, double click 
will only edit segments, it will not enter Properties. 

 

Enable All Libraries 

The Folders option and Libraries page now has an Enable All button to enable all libraries found. 
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New Style Folder Lists 

Where library and folder-based list boxes (such as Report Maker selection of Format Files) are 
used, it will now use the new style drop down which displays less information for clarity. This will 
declutter the list box where multiple folders and multiple files are available. 
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There is a preference to change this to the previous style where the full path is shown. This is 
available on the Folders dialog under General. In Version 8.5 the Show Folder For Each File (in 
the file dropdown lists) check box will be unchecked (to use the new feature). 

 

Show Group Name on Status Bar 

The group name of the selected items is now shown on the status bar.  

 
If an entire group (and only that group) is selected then Multiple Items is replaced with Group: 
<name>, otherwise the group name is added to the status bar. If the selected items contain more than 
one group, the main group is shown with three dots after it. 

 

Groups tab in Properties 

There is now a Groups tab in the Properties dialog showing which groups the selected items are on. 
The groups grid is read only and shows if all the selected items are in the group and also if the full 
group is selected. 
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Design Tooltips Expanded 

The tooltips selection section now has additional switches to display the item group and other 
information. This is available in the Options dialog under Interaction tab. New categories are: 
Group, Style Name, Style Size, Drill Size, Shape Size and Connection/Track Start End info. 

 

   
Example above shows 
a more compete PCB 
design tooltip 

 Example above shows 
a Schematic tooltip 
example 

Draw Current Interactive Grid Only 

There is now an extra check box on Grids dialog, Draw Current Interactive Grid Only, so that if 
checked, any grid being used by an interactive operation will be drawn (even if the particular grid is 
not displayed). If no grid is currently being used (like in Select mode) then the grids that are marked 
as Displayed will still be displayed.  

 
Note, if you type G 10 for example, in an interactive mode, the colour and style of the grid will be 
taken from the Working Grid. 
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Grids Displayed as X-Crosses 

There is now an extra ‘cross’ style in the Grids dialog to draw the grids as X Crosses (small 45-
degree cross in the design). 

 
Selecting this option displays the grid in the design like this: 

 

Lock Changes 

New Interaction - Don’t Pick Locked Items 

There is a new option, Don’t Pick Locked Items, in the Options dialog, Interaction tab. If checked, 
locked items will not be pickable in all circumstances (apart from Unlock latch mode). They will be 
drawn in a dimmed colour to indicate they cannot be picked (the same as if you make a Colours 
category non-pickable). 
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Layers Bar Lock Status 

The Picking of Locked items option is also on the Layers Browser bar so that it can be conveniently 
selected. 

 

Unlock latch mode 

Unlock latch mode will still allow picking of locked items. All locked items will be drawn in the 
highlight colour to make it easier to pick items to unlock. View Highlighted is on the context menu. 

Lock and Unlock Track Segment picking 

When using Lock and Unlock, you can now pick track segments (before it was always the whole 
track selected). Use Shift-click to select whole track. 

Apply Layout Pattern to Multiple Groups 

You can now use the Apply Layout Pattern option and apply the pattern to multiple groups which 
are then laid out in an array pattern. Next to the Group button, there is a new Multiple button. 
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Once selected, this opens up the Select Groups dialog from where you can choose the group or 
groups to be used. Once chosen, the group names appear as a selection on the main dialog. 

 

Selecting Multiple Groups 

Pressing the Multiple button next to the Group option, gives you this dialog.  

Use the Add button to add groups to the Result List (or double click on the Source List). You can 
change the order of the Result List using the Up and Down buttons. The order of the list determines 
the order they will be arranged.  

Once you press Apply Pattern, you are prompted to specify the arrangement of the groups. This uses 
the Rearrange Multiple Items dialog, which gives you a comprehensive set of arrangement options.  

 

Try To Retain Current Position 
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Check this option to apply the new pattern to the current pattern but without moving the current 
pattern position. This is useful where a change to the ‘master’ pattern has been made and you wish to 
re-apply it to the current pattern(s) without moving them. 

Net Names Displayed in Tracks 

Net Names can now be displayed in tracks. There are new switches in the Options dialog and 
Display to make various selections and text style choices. 

 

New View Highlighted option 

There is a new View Highlighted option on View menu. This is an alternative method to View 
Selection. 

 



36   Pulsonix Version 8.5 Update Notes 

Find Bar - Track Styles Changes 

On the Find Bar, Track Styles will now highlight just the track segments using styles. The View 
Highlighted option is available on the context menu. 

 

Reverse Engineer - Place Components To Match PCB 

This option now has a new component placement option Place Components To Match PCB.  

 
Use Place Components To Match PCB to place the centre of each schematic gate in the exact same 
position as the centre of the corresponding Component in the PCB design. If a schematic Component 
has multiple gates, they will be placed side by side, centred at that position. 
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The above illustration shows a small sample PCB before, and the Schematic design after the use of 
Reverse Engineer and Place Components To Match PCB with the Spread Out option selected. 

With Place Components To Match PCB selected, check the Spread Out box to move the schematic 
gates on to the Component Grid and spread them out so that they have a number of grid steps of space 
around them. This is also available as an interactive feature in its own right, see below for more 
details. 

Note: Two pin components will be automatically mirrored and/or rotated to have the same 
orientation as the PCB Component. 

After placement, the Components will be moved to the centre of the working area, any components 
still off the working area will be placed in the Component Bin. 



38   Pulsonix Version 8.5 Update Notes 

Spread Out Option 

There is a new Spread Out option to provide additional interactive tools for placement of items. The 
Spread Out option on the Utilities menu provides the ability to centre items between two points; 
Equispace items between two points and Spread Out items from an anchor point. 

When using Spread Out, a context menu is available to enable various spreading modes: 

 

Using the Spread Out option 

Use this interactive operation to spread out selected items in various ways to create space in the 
design. You can select the items to spread out before or after starting the function. 

There are four phases to the spreading operation:  

• Select the whole items, shape segments or track segments you wish to spread out.  

• Choose one of the three methods of spreading that can be used from the context menu.  
- Centre - Use this to centre the selection between two points or items.  

- Equispace - Use this to equally spread the selected items between two points or items.  

- Spread Out - Use this to proportionally spread the selected items away from an anchor 
point, radially or in a specified direction.  

• Click to define an anchor point where you want to spread out from.  

• Drag to spread out the items until they are in their required positions, or click to quickly define 
the second point to spread between. 

Below shows the effects of using Spread Out on a previously place PCB. 
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The picture to the left shows the ‘before’ and the picture to the right shows the effect after Spread Out 
from the Centre has been applied. 

The Spreading Methods 

The spreading method and direction affect how the spreading is performed. Each method is described 
here.  

Centre 

Use this to centre an item, or multiple items, between two points or picked items. For example to 
centre a selected track segment between two picked pads.  

If the spread direction is restricted to Linear Spread (Angle 90) the line between the anchor point 
and end point will be snapped to the closest 90 degree angle and the centre of the selected items will 
be aligned with the centre of this line. If Linear Spread (Angle 45) is used the line will be snapped to 
the closest 45 degree angle, allowing centring in a 45 degree direction. Using Radial Spread will 
centre the selected items at the mid-point between the anchor point and end point.  

If Align is enabled from the context menu, the centre of the selection will be moved onto the line 
between the two picked points. If left unchecked the selection centre point will maintain its original 
perpendicular distance from this line.  

If you have picked items to centre between, and they are not part of the selection, enable the Between 
Item Edges option from the context menu to centre the selection between the closest edges of the 
picked items, otherwise the origin of the picked items will be used. This option is useful when placing 
a track segment in the middle of the gap between a large and small pad.  

Equispace 

Use this to equally space multiple items between two points or two picked items. For example to 
equally space some parallel track segments between two picked pads.  
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If the spread direction is restricted to Linear Spread (Angle 90) the line between the anchor point 
and end point will be snapped to the closest 90 degree angle and the selected items will be spread 
equally in the direction of this line. If Linear Spread (Angle 45) is used the line will be snapped to 
the closest 45 degree angle, allowing spreading in a 45 degree direction. Using Radial Spread will 
first centre the selected items relative to their original positions at the mid-point between the anchor 
point and end point, and then equally spread them out along that line.  

If Align is enabled from the context menu, each item will be moved onto the line between the two 
picked points. If left unchecked the items will maintain their original perpendicular distance from this 
line.  

If you have picked items to equispace between, and they are not part of the selection, enable the 
Between Item Edges option from the context menu to equally spread the selection between the 
closest edges of the picked items, otherwise the origin of the picked items will be used. This option is 
useful when equally spreading several track segments in the gap between a large and small pad.  

Disable Equispace Outer Items on the context menu to specify that the outermost selected items are 
to be placed at the limits of the line, and the rest of the selected items equispaced between them. For 
example, use this to frame select five parallel track segments and have the inner three equally spaced 
between the outer two. Enable Equispace Outer Items to include a space between the line ends and 
the outer selected items.  

If Grid Items After Spreading is enabled, and the spread direction is a multiple of 90 or 45 degrees, 
an attempt will be made to keep the gaps equal by gridding them and moving the end items in a little 
so that the gaps are equal and all items are on grid.  

Spread Out 

Use this to proportionally spread out the selected items away from an anchor point. For example to 
spread out some components to make space for tracks between them.  

If the spread direction is restricted to Linear Spread (Angle 90) the line between the anchor point 
and end point will be snapped to the closest 90 degree angle and the selected items will be spread in 
parallel to that line. If Linear Spread (Angle 45) is used the line will be snapped to the closest 45 
degree angle, allowing spreading in a 45 degree direction. Using Radial Spread will spread each 
selected item radially away from the anchor point.  

Whilst dragging a selected item or point, it moves proportionally away from the anchor point in the 
spread direction. The status bar shows the scale representing this proportion. For example, if the scale 
is 2.0, all items have been moved twice their original distance from the anchor point.  

Import Placement CSV 

The PCB Design Editor allows the import of component data in CSV format. Use this import to create 
the basics of a design using placement information such as position and side, or to move existing 
components to critical locations based on information from another system.  

This is available from the File menu and Import Design Data option  

Component CSV Data 

The file must be in ASCII format and must have the file extension ".csv". The first row of the CSV 
file must contain the column headings for the fields, so that each column of data can be correctly 
identified. As a minimum, the file must contain a header line with Ref Name, Part Name, X and Y.  
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The full list of columns that can be imported is: Ref Name,Part Name,Side,Placement Centre 
X,Placement Centre Y,Rotation.  

Some of these can be identified in more than one way, to offer more flexibility in reading files from a 
range of other sources which may use different terminology to that normally used within Pulsonix: 

• Ref Name: Ref, RefDes, Comp Name, Component Name, CompName  

• Part Name: Part, PartName, Part Name  

• Side: Side, Mirrored, Mirror  

• Rotation: Rot, Rotation, Angle  

• X, Y: any heading containing an X or a Y  

If the Part Name field contains spaces, the field must be enclosed in double quotes " ", e.g. "R 
0.063W SMTF 9K".  

Values allowed for Side are: T[op] or B[ottom]. If the column defines a mirrored state instead, the 
values allowed are: Y[es] and N[o]  

Reading the file 

If a Ref Name matches a component that is already in your design, then that component will be 
moved to the location specified in your CSV file. 

If instead there is no component already in the design using that name, the Part Name will be used to 
add a new component to the design from your Pulsonix library. 

Empty values in the X & Y columns means the components are 'unplaced' and those components will 
be put into the Component Bin.  

Values defined for Placement Centre X and Y will be used to place the origin of the component at 
that location.  

Example 

An example of a full Component Position CSV file is shown below:  

Ref,Part Name,Side,Placement Centre X,Placement Centre Y,Rotation 
C1,"c",,Top,18700.0,21800.0,270.0 
R1,"R 0.063W SMTF 9K",,Top,19100.0,22100.0,0.0 
R2,"R 0.063W SMTF 9K",,Top,19300.0,22100.0,90.0 
R3,"R 0.063W SMTF 9K",,Top,19600.0,22100.0,0.0 
U1,"SN74AC00D",,Top,19300.0,21700.0,0.0 
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Cyclic Design Backups 

Options dialog 

Design Backups now have their own section in the Options dialog, previously this was on the 
General tab. 

 
New functionality for design backups is discussed below: 

Multiple backup copies 

On the Design Backups page you can now specify the number of copies that Security Copies and 
Backup Copy On Save will save before deleting older ones. 

Folders for Backups 

You can now define separate folders for each backup type. This can be done in the Design Backups 
page, or in the Folders dialog. 
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User defined format of backup file names 

You can create user-defined formats of the backup name by typing fixed text and inserting tags that 
will be replaced a when a backup name is generated. 

 
Tags are defined as the design name plus one of three numbering schemes – Increment, Decrement 
and Infinite. 

So for example, if number of copies is 3, Increment will produce copies 1 2 3 where 3 is the latest, 
Decrement - 3 2 1 where 1 is the latest, and Infinite 12 13 14 where 14 is the latest, i.e. it just keeps 
getting higher. 

For the Design Restore Points section, you can also select Restore Point Label from the context 
menu. 

Save and Load Restore Points 

There is a new type of backup that is saved on request, called a Restore Point, it is used for saving a 
design that is in a known good state before starting on a session of changes. Save the Restore Point 
using the Save Restore Point… option from the File menu. A dialog is displayed: 
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The saved backup is restored using a new option on the File menu named Restore Backup...  

From within the Options dialog and Design Backups page, you must provide a label for the restore 
point that will be inserted into its name. For this to happen, the name format must contain the label 
tag. 

 
For example if the name format was “$(DesignName) - $(Label)” then the user could create a restore 
point for design “MyDesign.Pcb” after autoplace with the label “Before Routing”, so the backup file 
will be called “MyDesign – Before Routing.pcb”. 

Restore Backup 

There is a new option on File menu named Restore Backup... to restore the contents of a design to be 
the same as a chosen backup file. This can be performed on the current design, or you can choose the 
design to have its contents restored from. When selected, this displays a list of backup files to choose 
from in the dialog. 
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Changes to Folder dialog 

The Reports entry in the Folders dialog has been modified and enhanced. Reports is now Design 
Reports and a Library Reports page has been added. This will enable reports of the different types 
to be specified. 

 
The formatting of these two dialogs using Report Templates is discussed in the immediate section 
below. 

Specifying CAM Plot and Report File Names and Locations 

You can now control where Reports and CAM Plots are written and the format of their file names. 

CAM/Plot 

Rather than checking boxes to say what is included in the CAM Plot filename, you can now define 
the filename and folder name using keywords that will be replaced with the relevant text when a plot 
file is created. This allows you, for example, to use the plot group name to separate plots that are 
project required as opposed to simple documentation. 

When using the Plot Settings page in CAM Plots, the Output File Names Based On section which 
previously had check boxes, has been now replaced with an Output File Names Template section 
that now has a template edit box and a popup menu button to make the name creation process more 
convenient when adding keywords. The popup menu button next to the folder edit box is used to 
make naming selections. 

The Folders dialog CAM Plot page also has the same new controls. 

Most keywords are straightforward, but there are a few that need additional explanation: 

$(PRE) and $(POST) are used to add pre-text and post-text either side of a variable field. For example 
“$(PRE)[$(Variant)]$(POST)” will be replaced by “[USA]” for a plot for variant “USA” and will 
produce nothing for a plot with no variant.  

$(DesignType) is replaced by “pcb” for a pcb design and “sch” for a schematic design. 

$(CombinedType) is the same as $(DesignType) but is only used if the filename is a combined output 
containing several plots (like pdf). 



46   Pulsonix Version 8.5 Update Notes 

 
The Design Attribute keyword can be used to insert the value of design level attributes into the 
CAM/Plot and Report file names. This is available in the Reports dialog, Cam/Plot Settings dialog 
and the Folders dialog. 

Choosing this keyword from the menu will add $(ATTR)%%attr_name%% to the template, where 
attr_name must be replaced in the template with the name of the attribute you want to use, e.g. If the 
design has an attribute JOB_NO with the value 1806, then $(ATTR)%%JOB_NO%% will be 
replaced with 1806 in the name. 

Reports 

Similar system to CAM Plots. Rather than using a drop down list to define when it included in the 
report filename, you can now design the filename and folder using keywords in a name template. 

In the Generate Reports dialog in Reports, the Report Names Based On section had a drop down 
list which has been now replaced with a Report File Names Template section with a template edit 
box and a popup menu button to make it easier to add the keywords. There is also a popup menu 
button next to the folder edit box as well. 

The Folders dialog and Reports page also has the same new controls. 

The “$(Report Group)” keyword will be replaced with the new report group the report is in. On the 
General Reports page there is a Report Group box to supply the group for each of the standard 
reports. User reports can have a report group assigned by including the new Set Report Group 
command in their script. 
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Adding Conditional Report and CAM Plot File Templates 
There is now a set of advanced keywords that can be used to create conditional CAM Plot and 
Report folder and filename templates. For example, this functionality can be used to create 
completely different plot file names for some of the different plot types. This effects the Reports 
dialog, CAM Plot Settings dialog and the Folders dialog. 

There are a set of advanced keywords that can be used to create conditional folder and filename 
templates. For example to have completely different report file names or folders for each of the 
different design types. The following keywords are not on the menu as they have to be combined as a 
set, but they can be inserted by hand. Care must be taken when inserting conditional templates and 
should only be attempted if you know what you’re doing. 

$(IF) $(MATCHES) $(THEN) $(ELSE) $(ENDIF)  

If the text following the "$(IF)" keyword matches the text following the "$(MATCHES)" keyword, 
the text following the "$(THEN)" keyword will be included in the name, otherwise the text following 
the "$(ELSE)" keyword will be included. There must always be a "$(ENDIF)" keyword at the end of 
the condition. Using "$(MATCHES) allows you to use wildcard characters in the text following it, 
but you can replace it with keywords "$(=)" or "$(!=)" to test exactly equals or not equals 
respectively. Note: nested conditions are not allowed, i.e. an "$(IF)" keyword should not be placed 
inside another "$(IF) ... $(ENDIF)" sequence. 

For example, for design "myDesign.pcb" with design level attribute "Issue" with value "V02" the 
following template "$(DesignName)-
$(IF)$(DesignType)$(MATCHES)PCB$(THEN)$(ATTR)%%Issue%%$(ELSE)Drawing$(ENDIF)" 
will produce "mydesign-V02" for a PCB design and "myDesign-Drawing" for a schematic design. 

Specifying Parts and Symbol Library Report Names and Locations 
The formatting and location of reports from within the Library Manager for both the Schematic 
Symbols and Parts has been modified to enable more accurate reporting. 

The dialog below shows the Parts Library Report page: 
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The Report File Name Template button opens an additional menu from which to make name 
selections: 

 

Override Component Pad Position 

As well as the Style, you can now override a Component Pad position and rotation. This is a 
generic feature and so also applies in a Schematic as well as a PCB. It also applies to Doc Symbol 
Pads, Component Mounting Holes and Component Vias. 

This is presented in the Properties dialog for a Component Pad as a set of Override check boxes. 
These replace the previous Alternative Pad Style check box and the Override switch for pin type. 

Note. The Layer cannot be overridden and is displayed here for information only. 

 
There is also a new Allow Interactive Reposition check box. If selected, the pad can be interactively 
moved and rotated to reposition it. This also allows you to align it with another item. By default this 
is unchecked to not allow interactive repositioning. 

Reload From Library 

Reload From Library now includes additional switches Keep bond pad position/style overrides 
and Keep pad position/style overrides, which replace the Keep bond pad positions and Keep 
alternative pad styles switches.  

There is also now a Keep pin positions/style overrides switch in Schematics. 



 Pulsonix Version 8.5 Update Notes   49 

 

Design Revision Analysis 

The Design Revision Analyser option will now report all overridden pads. 

Report Maker 

The Report Maker option now has a set of Is XXXX Overridden commands and a set of Original 
XXXX commands. For example Is Position Overridden and Original Position. 

Note. Is Style Overridden replaces Is Alternate Style and Is Pin Type Overridden replaces Has 
Local Pin Type commands. These commands can be used to report where component pads have been 
physically changed in a design. 

There is a new format file Overridden Pad Details that is installed by default with Version 8.5 

Allow Interactive Reposition for Bond Pads (Chip Packaging Toolkit Option) 

If you have the Chip Packaging Toolkit option, Bond pads will now use the new Allow Interactive 
Reposition feature to enable you to lock them against repositioning. When a component with bond 
pads is added to the design, all bond pads will initially have Allow Interactive Reposition off, and so 
they cannot be accidentally moved. By default this is unchecked to not allow interactive 
repositioning. 

 

Copy Tags status in Attribute Editor 

The Copy Tags option in the Attribute Editor now also applies to pasting. When pasting with Copy 
Tags off, the visibility is kept as it was. 

As a reminder, the Copy Tags option controls the copying and pasting of the 'visible', 'fixed' and 
'undefined' state information. If you want to copy just the text without the state tags you can uncheck 
the Copy Tags option. 
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Position STEP Model 

Within the Footprint Editor and PCB Doc Symbol Editor, a graphical method of defining <STEP 
Filename> <STEP Offsets> and <STEP Rotations> attributes has been added.  

The Position STEP Model option is available on the Tools menu. 

Selection of the STEP Model name is by way of the drop down list box from models available in 
your system. 

 
Offset values and Rotations are added by typing them into the appropriate boxes. Once values have 
been added, the preview of the model on the footprint will be updated. This allows you full graphical 
control and visualisation of the changes that you make. 

Colours - use the Colours button to set the colours and solid entity status of the Preview window. 
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Select STEP Filename Model from drop down list 

When using the Insert Attribute option, for the <Step Filename> system attribute, you can now use 
the drop down list to select the STEP model filename. This list is read from the STEP model names in 
the search list. 

This is available when adding the <Step Filename> attribute in the design using Properties, through 
the Attribute Editor, or when adding this attribute in the Footprint Editor and in the Part Editor 
when adding this attribute. 

 
On selection, you are presented with a drop down list containing <Place Holder Only> plus a list of 
any available STEP model filenames. 

STEP Model Name in Attribute Editor 

When using the Attribute Editor, if you choose <STEP Filename as a new attribute name, you can 
then choose the STEP model name from the drop down list presented within the editor cell. 
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Attribute <STEP Filename> available for Doc Symbols 

The <STEP Filename> attribute can now be used in PCB Doc Symbols. It works the same way as 
for Component footprints. This can be used for items such as mounting screws and mounting 
hardware. 

 

Save STEP Models Option 

There is a new command for a PCB design to save a copy of all the step models used in the design to 
a separate folder. The Save STEP Models command is available on the Utilities menu. 

 
This, along with the changes to specify separate folders for important CAM files and reports, makes it 
easier to create a release folder tree containing all important files that can easily be archived or sent 
for review etc. 

The dialog will show you the results of analysing the components and documentation symbols in your 
design for STEP model file usage. 

• How many have model file names assigned where those model files exist in your STEP 
model folders, and the number of model files found.  

• How many have model file names assigned but those model files cannot be found.  

• How many have no model file name assigned.  
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• How many have a model file 'suppressed' (by adding the STEP Filename attribute and 
leaving the value blank).  

You can click the Report button to get a simple report of the models found (and not found) for your 
design. 

To save the model files to a particular folder, use the Browse button to locate the desired folder, then 
click Save Models to make a copy of all model files found, from their existing location into that 
folder. 

Report 

A sample report provides you with this information: 

STEP Models 
----------- 
Report Written : 25/11/2014 12:07:15 PM 
Design Path    : C:\Reference\Designs\STEP Example.pcb 
Design Title   :  
Created        : 01/02/2011 11:31:26 AM 
Last Saved     : 12/10/2012 11:17:25 AM 
Editing Time   : 17 min 
MODELS FOUND FOR ITEMS IN DESIGN 
-------------------------------- 
    Model name                      Items using model 
    ------------------------------------------------- 
    c-5102321-1-d-3d.stp            1 
    dpak3p-841x1018h444.stp         1 
    plcc-44p1658x1658ls127h439.stp  1 
MODELS MISSING FOR ITEMS IN DESIGN 
---------------------------------- 
    None 
MODEL FOLDERS 
------------- 
    Model                           Folder 
    -------------------------------------- 
    c-5102321-1-d-3d.stp            C:\Reference\STEP Models 
    dpak3p-841x1018h444.stp         C:\Reference\STEP Models 
    plcc-44p1658x1658ls127h439.stp  C:\Reference\STEP Models 
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PDF Output – Embed Fonts 

When using the CAM Plots output and PDF, you can now choose whether you want to embed fonts 
in your PDF. In the PDF device setup dialog, select the Embed Fonts in PDF file to embed the font, 
previously this was done by default. For example, Arial Unicode is a very large font on disk and 
hence the output PDF is also very large. 

 

Support for Gerber X2 

From within the CAM Plots dialog you can now select X2 as the Gerber format for export. This 
switch is in addition to the existing RS-274-D and RS-274-X formats. By default, this option will be 
pre-selected with the RS-274-X format. Selecting X2 will enable the three new options at the bottom 
of the dialog. 

 
At any point, individual check boxes can be selected to enable elements within the Gerber export 
format. Note that some of the commands for X2 may appear in the 274-X format as well. 

Cross Probe of Star Points 

You can now cross probe Star Points in your designs. Note: Star Points must be defined as Pulsonix 
Star Points using the special Doc Symbol type. 
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Enable Net Styles From Technology Dialog 

As well as enabling the Technology Net Styles from the Design Settings dialog, General page, you 
can now also enable it from with the Technology dialog and Net Class page as well. The same 
verification checks and warning dialog will be displayed; this is just a more convenient method to 
enable it. 

 

Text Callouts with Net Names 

Text Callouts can now be attached as part of a single pin Doc Symbol to define a signal reference 
symbol, A Net Name attribute can also be attached within the Text Callout which, when used in the 
design, will dynamically resize to fit the net name length. 

 
Three new Text Box shapes have been added to a callout definition: Pointer Left, Pointer Right and 
Pointer Both. All three examples are shown in the picture above. 
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You can also make the Pointer Line: None for the connecting line between the box shape and the 
terminal if you just wish to display the box shape. 

 

Text Callouts and Net Name Attribute 

When adding a Net Name attribute to the Text Callout, use the Attribute Substitution button to 
add the system %%<Net Name>%% attribute. The %% is required if manually typing in the attribute 
name so that Pulsonix knows to pick up the attached Net Name and not just simply display plain text. 

 

Text Callouts and Net Name Text Alignment 

Within the Text Callout box, you should also be aware of how the actual Net Name attribute name 
is positioned relative to the box itself. It is advised that you position it using one of the ‘Middle’ Text 
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Alignment options and either Left, Right or Centre depending on the Pointer direction. This way, 
the box will ‘grow’ dynamically in a suitable direction depending on the Net Name size. 

 

Text Callouts in the Design 

You can now attach Text Callouts to Component pins in a design to display information about the 
pin. Previously, it always attached to the whole Component. Again, this can be used instead of 
displaying a Net Name on a pin if you want a box around the net name. This can be an alternative 
method to using the new Doc Symbol Text Callout and Net Name mechanism although you will have 
to edit the Text Callout Properties in order to get the required parameters. 

The Attribute Substitution in Text Callouts can be used to create some useful combinations such as 
Net Name and Net Class, for example %%<Net Name>%% [%%<Net Class Name>%%] (using 
additional square brackets for notation). 

 

Text Callouts and Schematic Junctions 

You can now also attach Text Callouts to Schematic Junctions and Bus Terminals. 
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Override Exclude Callouts From Plot 

There is a new check box Plot Even If Callouts Excluded on the Callout Properties dialog for 
Schematic and Schematic Symbol designs. Use this if you are generally excluding Callouts from 
Schematics plots, but require some Callouts to be plotted, for example Callouts that are used to 
display net names. 

 
Below shows the CAM Plot dialog and the Exclude dialog. With this situation and Text Callouts 
generally excluded, it the Plot Even If Callouts Excluded check box is selected, then specific 
Callouts will be plotted. 

 

Preset default Resolve Net Name parameters 

The default action of the Resolve Net Names dialog is now determined by options set up on the new 
Options dialog, Resolve Net Names tab. 

You can choose to default Merge or Rename on Power/Ground, Global and Local nets. You can 
also choose if the Revolve Net Names dialog is shown when your selection contains nets of certain 
types. 

These choices can be made differently between Schematic and PCB designs. 
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Additional DRC Checks 

Net Connectivity Check 
The Net Connectivity check now has a Power Plane option which does a more in depth check of 
breaks in power plane copper - in particular split planes. Note: This can be much slower than the 
normal Connectivity check. 

 

Panel Item Check 
There is a new Panel Items On Board check for use when creating panels. This new check will be 
used for items which have been flagged on their Layer Class using the new Check Items Outside 
Board check. See below under Panel Checks in Layer Class dialog. 

 

Stub Vias Checks 
There is a new Stub Vias check in the DRC dialog under Nets. This will check for tracks with 
dangling ends, or ending on vias which do not appear to connect to template or plane. 
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Checking of Cross Hatched Copper 
With the Hatched Copper check option in the Technology dialog and Design Rules tab enabled, the 
DRC and Copper Pour options now take the gaps between hatch lines into account when reporting 
spacing errors, and when avoiding obstacles when pouring. 

 

Staggered Micro-Via spacing 
In the Technology on the Design Rules page, you can specify a minimum stagger distance between 
micro-vias on adjacent layer spans. There is also a check box (which defaults to on), to allow stacked 
micro-vias even when a stagger distance is specified. 

 
The Stagger distance, is the minimum centre to centre distance between micro-vias on adjacent layer 
spans. 

 
Allow Stacked Micro-Vias allows centre aligned micro-vias on adjacent layer spans, even when the 
Stagger distance is not 0. You can automatically insert Stacked Micro-Vias using Composite Spans. 
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Hatch Lines Using Percentage Width and Offset 

From within the Technology dialog and Hatch Styles, you can now specify the width of the Hatch 
Lines as a percentage of the line style. You can also offset a hatch style as a percentage of the 
separation between lines. These controls have been added to provide you with more control over the 
poured hatched copper. 

 
Width Percent gives a hatch line width in terms of percentage against the Template shape line style 
width. This is useful if you wish to adjust the hatch line styles without adjusting the Template outline. 
Must be greater than 0 and less than or equal to 100%. The default setting is 100% 

Offset Percent gives the offset of the hatch lines from its original position, given as a percentage of 
the line separation. You must wish to ‘move’ (offset) the hatch line positions to ‘hit’ or avoid other 
obstacles within the pour. The value must be between 0 and 100%. The default setting is 0% 

Below are various scenarios to illustrate the affect the two new settings have on poured copper: 

 

 ‘Normal’ poured copper 
showing the hatched line style 
being the same width as the 
template. 

 

 

 

Using a Width: adjustment of 
50%, the hatch line style is now 
50% thinner than the template 
width. 

 

 

 

 

This picture is zoomed to show 
the effect. 
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This illustration shows an 
offset of 0% (normal); the 
hatch line is centred on the 
pad. 

 

 

This shows the effect of 
making an Offset of 50% to its 
original position. The pad is 
now straddled between two 
hatch lines. 

Construction Lines 

Dividing a Circle 
You can now can use the Divide mode with Divide Angle enabled to add lines to divide up a circle 
(or circular pad). The context menu option is now called Divide Angle (previously, it was Divide 
Angle Between Two Lines). 

 
When in Divide mode and are dividing angles, you now just click on an arc or circle to divide it 
(previously you had to Ctrl-click to select arcs). A prompt on the status bar now shows that you can 
pick arcs and circles.  
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Using the Divide function within Construction Lines to divide a circle allows you an alternative to 
using Polar Grids (which can still be used). If your requirement is calculated to an uneven number of 
lines, say 11, the Divide number must be doubled on addition. This is because Construction Lines are 
infinite lines and do not stop at the centre of the circle. This is shown in the example below where 11 
LEDS are placed on equal increments around the circle. 

 

Change Divide By  

When in Divide mode, there is now a new Change Divide By option on the shortcut menu to change 
the divide number. This can be used if say, you first choose to divide by 2, then subsequently need to 
divide by 3. 

 
Also, if dividing an angle and you select a circle or round pad you will be presented with a dialog to 
specify the start angle for the dividing lines. 

 



64   Pulsonix Version 8.5 Update Notes 

Snap to Edge 
A new option, Snap To Edge, has been added. When selected from the context menu, this will cause 
the construction line being added to snap to the nearest edge of the picked item, rather than snapping 
to its origin or centre line if it is a segment. 

 

Add Mirrored Line 
When adding a single construction line there is a new option Add Mirrored Line available on the 
context menu if you had a pre-selected construction line, or have used Ctrl-Click on an existing 
construction line, or are using duplicate. 

Use this to add a copy of the current dynamic line, mirrored about the original picked line. 
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Via In Surface Mount Pads 

From within the Technology dialog and DFM/DFT page, you can now allow vias in surface mount 
pads. You can also control Normal and Micro-Vias separately. 

 
These are used when running the Via In Pad check in the DRC option. 

Optimise on Delete 

There is a new option to only perform optimise on signal nets when performing delete and other 
related operations, such as unroute track path. This significantly speeds up performance on larger 
designs, whilst still optimising most nets. The Optimise Only Signal Nets option is located on the 
Options dialog and Interaction page. 
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No Undo/Redo on Pan/Zoom 

From within the Options dialog and Interaction (PCB & SCM) tab, there is now an option to turn 
off Pan/Zoom for Undo. With this switch unselected, if an Undo is performed, it means that only the 
function will be undone and not the Pan or Zoom levels. Select this option to perform Undo as it 
previously was. 

 

Layers Bar - Show/Hide Pin Names 

The Show/Hide Pins Names option is now also available on Layers Browser Bar in the PCB design 
editor. You can still also use the Colours dialog or Component Properties dialog to change their 
display status. 
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Find Changes 

Option to Find in open pages only 
Find now has an option to Search All Open Pages. This is available on the context menu when using 
the Schematic editor. 

 

Find by Block Instance 
You can now Find Block Instances by block.  

  
The above example shows Find on 
a Block where two different Block 
types have been added (by adding 
the Half Adder example). 

 The above Find example is of the 
same Half Adder block added 
twice to the design. The Block 
Instances are broken down to 
individual instances so they can 
be located by instance name. 
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Option to Only Open Last Active Page 

There is a new option in the Options dialog and Display page to Only Open The Last Active Page 
in a Schematic design. This saves time when opening a large design with many pages open; it will 
only open the last active page that you had open at the time of closing. 

 

Report Maker – New Commands 

Two changes have been made to the Report Maker: 

A new command has been added – Is Via In Sm Pad This will test if a drill hole is a via in a surface 
mount pad. 

 
The Variable command has been modified. You can now initialise a variable with multi line text. 
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When the script is run, the message displayed will be multi-line. 

 

Using Reports Folder Template Keywords in Report Maker 
You can now use the new Reports folder and file name template keywords within the Report File 
Name command in the Report Maker. See the Adding Conditional Report and CAM Plot File 
Templates section above. 

Changes to the Variable Command 
The Variable command has been enhanced: 

Changing Text in the Progress Bar 

You can use a variable to change the text in the progress bar, this is useful when running library-
based reports for example. 

 
The Edit Variable dialog will allow you to select Show Value In Progress Bar. 
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When run, the progress dialog (for this example) will insert the Library name to show which one it is 
accessing. 

 

Prompt String in a Variable 

When using a variable prompt command, you can now use a variable to provide the Prompt string and 
default answer at runtime. For example to prompt “Add value for Component R1”. 

 

 
When run, a prompt message is presented: 
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Prompt String in a Variable – Default Value 

Using a variable to provide the Prompt string, you can also set the Default Value for the prompt. 

 
Once run, this default value will appear in the prompt dialog but can be overwritten with a typed 
value. The drop down list will also allow you to set the default value between a Fixed Value which 
you type, or a Variable, selectable from the drop down list of defined variables. 

Variables within the Replace Text Command 

For the variable replace text command, you can now use variables to provide the replace text and 
replace with text at runtime. In the example below, the replace text is extracted from the text file. 

 
The Variable dialog now shows the Replace Text value and With Text as a drop down list boxes. 

 
Contents of C:\Users\Public\Documents\Pulsonix\Formats\MyHeader.txt 

============================ 
Design Name: %NAME% 
Designed By: %AUTHOR% 
REVISION:    %REVISION% 
============================ 
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Whitespace characters 

Also changed: when replacing whitespace characters is now in the drop list, rather than being a 
separate check box. 

 

Substituting System Environment Variables into the Variable Value. 

There is now a new variable command to substitute system environment variables into the variable 
value. 

 
The Edit Variable dialog will allow the Substitute Environment Variables: check box to be 
selected 

 
Selecting the Substitute Character: check box allows you to define the Substitute Character if it is 
going to be different to your default. If you leave it unchecked, the default will be taken from the 
Options dialog and General setting. 

Minor Scripting Changes 

Scripting in V8.5 has now been extended to facilitate Library Reporting.  
A new RunLibraryReport method has been added for an Application object, and a new RunReport 
method has been added for a PartLibrary object. The Online help for Scripting has more specific 
details on how to use this implementation. 

By providing a script file on the command-line, it can be used within a scheduled task and when 
launched in conjunction with the /hidden switch, it can be used with the Task Scheduler 'Run whether 
user is logged on or not' option set. 
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Enhancements to Import Class To Class Spacings CSV 

Spacing CSV Applied To Layers and Areas 
When importing Spacing CSV files through the Technology dialog, Spacings, Match Net Class 
Pair Import dialog, you can now choose which Side, Layer and Area to use when importing a CSV 
file table of class to class spacings. 

There are extra controls for this at the bottom of the Import Class To Class Spacings CSV Data 
dialog. Set Side to <Any> and leave Layer and Area blank to import spacings for all layers. 
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Multiple selection  
You can now select more than one class pair in the list (using standard Ctrl, Shift and combination 
keys). The Delete and Move buttons will act on the multiple selected items. If the selected items are 
not sequential, after using one of the move buttons they will become sequential. Newly imported 
Class to Class Spacings will be added to the top of the list (as before) and will now be selected. This 
enables you to move them all to the bottom of the list by pressing the Bottom button for example. 

 

Floating Network Licensing – Disconnect Client at Admin Level 

If you are using a floating network license system for your Pulsonix licensing, from the server end, it 
is now possible to force a client to disconnect and release its licenses. This can be useful in situations 
where a Pulsonix application has been left running on a remote computer, effectively ‘blocking’ those 
licenses from being used by someone else. 

A new administrator-level command Disconnect Client has been added to the Tools menu in 
NLServer (server as application, or when run as server ‘Monitor’). To use this, select the entry in the 
table on the Connections tab and choose the new menu command. Confirm the prompt, and the next 
time the client sends its ‘still alive’ signal to the server it will receive a response that instructs the 
client to disconnect. 

The client will then behave as it would if the network connection had been lost. When the user 
resumes working with the client application, if it cannot re-establish connection to the server then the 
user will be able to save any open files before closing and restarting the application, after which the 
licenses will be released back to the pool. On the client end, the application will go into the ‘network 
disconnected’ mode; they will still be able to save their work, then close and restart the application to 
acquire a new set of licenses. 
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Technology Files 

Changes to existing Technology files 
All existing technology files (SCM and PCB) have been enhanced to check and remove previous style 
inconsistencies’.  

New Technology files 
A new technology file named flexirigid4.ptf has been added. This can be used when creating a flexi-
rigid PCB of 4 layers; two ‘normal’ electrical layers and two electrical flexi layers. 

Library Changes 

New Library Parts Added 
New Library Parts have been added to the MasterLibraries for TDK filters. 

The existing Hamlin parts have been modified reflecting manufacturers Part numbers, technologies 
and footprint areas. Footprints have been amended or created for the new Hamlin Parts added. 65 new 
Hamlin Parts for their range of SMT reed switches have been added. 

The existing Omron parts have been modified and updated; adding full Part Numbers and 
descriptions. New Parts have been added totalling 152 library Parts. 

New Doc Symbols Added 
New Doc Symbols have been added to both the Schematic Doc Symbol and PCB Doc Symbol 
libraries. 

Schematic Doc Symbols for Left, Right and Both Pointer types that include the new dynamic net 
naming feature as a callout. New symbols are also included for alternative Drawing Borders in 
Portrait and Landscape modes. 

PCB Doc Symbols are included for general documentation purposes such as CE-Mark, ESD, Draft 
and ‘For Information Only’ symbols. 

Revised Footprint Libraries 
Below is a summary of changes made to the footprint libraries: 

- Existing footprint libraries have been removed and replaced with more logically named 
alternatives. All existing footprints have been retained and library sets have been added to, see 
below. 

- Rationalisation of areas on chip resistors, capacitors, diodes and inductors. Placement Areas have 
been modified to bring more into line with realistic placement areas required. 

- Addition of more complete sets of chip resistors, capacitors, diodes and inductor series. 

 


